
How to build an arcade cabinet for use with MAME
By SpyStyle Inc
spystyle@yahoo.com

Chapter one : Introduction

Hello from Maine, My name is Craig and I like to build arcade cabinets !
I have an extensive background in construction and computers.
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In this tutorial I will show you step-by-step how to build an arcade cabinet that is inexpensive, 
strong, and very fun to play. I will try to make this tutorial as thorough as possible, comments,
questions, and suggestions for future revisions are always appreciated.

Copyright statement

This tutorial and it's entire contents are copyright 2004 SpyStyle Inc (excluding the picture
below of the William's Defender Stargate 2&1 cabinet and the images in the 'shopping list' )

This tutorial may be distributed in whole, unmodified, freely.

Mission statement

I'd like to consider this my contribution to the MAME arcade cabinet builder's community. Are
you new to the community ? Check out Saint's site 'Build your own arcade controls'
www.arcadecontrols.com and MAME's official site  www.mame.net . I am sick of seeing 1
megabyte large, poorly documented plans selling on the internet for as much as $75. These
overpriced commercial plans are NOT in keeping with the spirit of MAME software, which is
free and designed to keep the classic games alive. I encourage you NOT to buy commercial
plans, instead download the cabinet blueprints from www.jakobud.com ,
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www.mameworld.net/massive/ and  www.minimame.com and use this, and other free tutorials
on the internet, to build your MAME arcade cabinet. Help fight the commercialism : take
pictures of your cabinet creation process, document your findings and distribute them !

Disclaimer

As stated above, this tutorial is meant to help forward the arcade cabinet builder's community.
However, operating power tools can be dangerous, as can working with electricity, open
computer power supplies and open monitors and televisions. Be safe, read the manuals that
come with your power tools and heed the safety warnings, always wear earplugs and safety
goggles when cutting and drilling. Work in a well lit area while  sober. Don't open your
computer's power supply and should you be working with open monitors and televisions  be
sure to discharge them first or have them discharged by a certified technician. A tutorial on
discharging monitors can be found here :
http://www.mameworld.net/massive/How-to/how-to.html . I encourage you to take safety
measures very seriously, I will not be held liable for injury or misuse as a result of these
instructions.

Alternatives

Alternately you could buy a retired arcade cabinet, restore it and convert it to your liking. In my
sincere opinion building your own arcade cabinet is a fun and rewarding experience, it allows
you to have exactly what you want for a fraction of the price of a new arcade cabinet and gives
you the satisfaction of creation and artistic expression. However, it is a time consuming
process. I have the idea (although I haven't tried it) that you could post and ad in the
newspaper that states "Wanted : Arcade machines in any condition, will pay $25-$50". Should
you come across a retired arcade cabinet I recommend you do some Google searches for
'arcade restoration' and 'MAME conversion' as both topics are well documented.
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Chapter two : Shopping

After you find a cabinet plan that suits you, you'll need to go shopping. For this tutorial I will be
building a William's Defender Stargate 2&1 cabinet. I will be using particle board but I will
recommend MDF as it is very smooth and adequately tough.

Tools : (no battery tools, they haven't enough balls/torque/amperage)

01. 3/8" Drill (or larger, keyless chuck is a plus)
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with the following bits :
"pilot point" drill bit set
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1 1/8" drill ("spade bit") (for buttons and sticks)

countersink bit (so you can patch over your screws)

phillips head bit (for driving the screws)
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02. Jig-Saw (this will be the tool used most)

with "fine" wood cutting blades (at least 3, 1 blade per sheet)

 

03. Finishing Sander
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04. Plunge Router (1/4", for the side panels and control panel)

You will only be using this tool for one hour per cabinet, so you may want to rent one instead of
buying.

with 1/16 slot cutting bit (if you want t-molding)
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or
with 5/8 roundover bit (if you do not want t-molding)

05. Rubber Mallet (for closing the paint can and for pounding the t-molding into place)
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06. Paint can opener (or large flat-head screwdriver)

 

Material :

(call around, your local lumber yard may deliver these to your door for less than it costs to haul
them yourself from Home Depot)

3 sheets of 4'X8' X 3/4" MDF (medium density fiberboard)

 

MDF is adequately tough, and holds a screw pretty well. I think it is ideal for the new builder as
it is very smooth and sturdy enough for a home arcade.

However, if you are building an arcade cabinet that may have to withstand extreme abuse (i.e.
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bar, public arcade, falling over, falling down stairs, getting submerged, bouncing around in the
back of a truck, falling off the back of a truck, etc) I recommend you use 3/4" particle board.
Particle board is extremely strong, holds drywall screws extremely well, can handle extreme
abuse, and it is cheap. Unfortunately particle board has a bad texture and needs a complete
surface treatment. Particle board can be wallpapered, laminated or have a sheet of hard board
glued to it with wood glue.

20 feet of 2"X8" board "two by eights"

(ie: two ten foot two-by-eights)

 

(200) 2" coarse thread drywall screws (wood screws are soft and strip easily)
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(4) 2" casters (front : "swivel/brake casters" rear : "fixed" casters)
(make sure your casters total weight specifications = 300 lbs.)
(i.e.: 4 casters rated @ 75 lbs. = 300 lbs., can hold your finished cabinet up)

 

 

1 gallon can of latex interior primer
1 gallon can of latex interior black paint
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paint brush (with nylon bristles)
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painter's pail

(2) saw-horses (I saved a bundle by using Home Depot's "build your own Saw-Horse brackets"
+ 2X4s)

work light(s)
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Drywall T square
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clamps

square
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tape measurer (I recommend getting one that lists the fractions)
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many pencils and electric pencil sharpener

many earplugs and a pair of safety goggles
I can not stress this enough : wear earplugs and safety glasses whenever you operate electric
tools.

optional : T-molding, 40' 3/4" black
($20 (shipped) from www.t-molding.com)
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T-molding.com also sells other sizes ranging from 1/2" to 1 1/2"

 

Cabinet parts

01. Joysticks and buttons ( www.happcontrols.com )

Before you consider buying an expensive pre-made MAME control panel know that it is very
easy and inexpensive to make your own, in this tutorial I will show you in detail how.

02. Marquee ( www.ebay.com )

03. Marquee retainer ( www.happcontrols.com )
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If you order this item from Happ's website it will cost $12.05 + $30.00 shipping as they use UPS
by default. However, if you call Happ at 888-BUY-HAPP (289-4277) and order it with USPS
shipping it will only cost $20 total ! It is part # 49-1000-00 Retainer for video game marquee

04. Keyboard encoder ( www.groovygamegear.com )

25" - 32" Television
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Televisions can be easily interfaced to computers, and their resolution is in keeping with real
arcade monitors. In this tutorial I am building an arcade cabinet that tries to capture the
authentic arcade experience. Walk around your local arcade with a tape measurer and
measure the screens diagonally, you will notice that real arcade cabinets have large screens.
Too often when I browse the internet I see the arcade cabinets that my fellow builders have
constructed contain enormous control panels and tiny little screens, this is NOT in keeping with
the real arcade experience and in my opinion is an absolute travesty as real arcade cabinets
are quite the opposite ! I am convinced that this trend is a result of the high price and small size
of the average computer monitor, but large televisions on the other hand are relatively
inexpensive. Furthermore, after constructing several cabinets and watching my beta testers
and family play I have drawn the conclusion that the ONLY thing people notice while playing is
the screen. Therefore I recommend using a 25" or larger television, when you are finished you
will be VERY glad you did !

optional : Coin door ( www.ebay.com, www.happcontrols.com)
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In this tutorial I will be building an arcade cabinet with a non-functional coin door. There will be
a 'coin' button for credits, alternately it would be easy to build a MAME arcade that requires
quarters. Either way, in my opinion,  coin doors go a long way towards building an authentic
looking arcade cabinet, and can be acquired for as little as $20 (shipped) off Ebay.

This tutorial and it's entire contents are copyright 2004 SpyStyle Inc
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Chapter three : Construction

Part 1

It is a good idea to measure the doorways and stairways leading to where your finished cabinet
will live. (optionally you can mount the control panel with brackets so it can be removable should
it be too wide for your doorways)

Remember : taking your time on this project will save you from making costly mistakes.

Lay the 1st sheet of 4'X8' MDF onto the saw-horses, using a very sharp pencil draw out the left
side of your cabinet, check your measurements twice before cutting it out with your Jig-Saw,
while cutting it out be sure to wear safety goggles and earplugs.
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When cutting angles you may need to drill a pilot hole to reposition the jigsaw blade.
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Once you have cut out the left side panel place it on top of another sheet of 4'X8' MDF, line it up
square and clamp it, using a sharp pencil trace the side panel onto the new sheet and cut it out.
For best results switch to a new jig-saw blade now.
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If you are NOT going to install T-molding in your cabinet now is a good time to route all sides of
the side panels, front and back (except bottom) with the 5/8 roundover bit .

If you ARE going to install T-molding do NOT get your router out yet.
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Now that the side panels are cut out all that remains to be cut will be rectangles and squares
(very easy) following your plans cut out the remaining pieces. For best results switch to a new
jig-saw blade now.

If you plan on using plexi glass on top of your control panel cut the control panel out of 5/8"
material (5/8" wood + 1/8" plexi glass = 3/4" panel) (covered in chapter four)

It's a good idea to measure your screen before cutting out the other panels, should your screen
be wider than the cabinet plan's width simply scale the width to that of the screen plus 2"
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The control panel is cut out of 5/8" material (to allow for 1/8" plexi glass) all other panels are 3/4"
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Pictured is a small table saw, however, all of my previous cabinets were cut out entirely with a
jig-saw. (including the Pac-Man at the top)
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After all of the panels are cut out it's time to cut the studs, the studs made of 2"X8" boards will
help reinforce the cabinet and make it very strong. Cut out 5 studs to the same width of the
panels.

2 studs for the bottom, 2 studs for the middle (to reinforce monitor shelf) and a stud for the top.
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Now that all of the pieces are cut out, it is good to mark boundaries on the inside of both side
panels before assembly begins. I use an inset of 1/2" on all sides except the bottom, and the
material is 3/4" so I will draw a line 1/2" in on all sides (except bottom) of the inside of my side
panels, this will provide a boundary line when assembling the panels so I don't accidentally
compromise my inset. I will also draw a line 1 1/4" in on all sides  (except bottom) to provide a
visual marker for the back of the panels (1/2" + 3/4" = 1 1/4")

When I draw my long boundary lines I use the square to mark 1/2" and 1 1/4" (point A and point
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B) then connect them by clamping my 24" ruler and drawing the line.
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Next attach the floor panel, place your side panel up on the sawhorses and clamp it into place,
then mark with a sharp pencil where the floor panel will go, have a helper hold the floor panel
while you attach it from under.
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You can use your square and level to help align the panels before attaching them.
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Remember : measure everything twice before attaching and verify by 'dry fitting' the panels, if
you take your time on this project you will have no costly mistakes

Pay attention that the floor panel is not flush with the front of the cabinet (recess plus the width of
front panel)

The procedure for screwing the panels in is a 2" coarse thread drywall screw every 3", this
results in a very strong arcade cabinet.

For every screw :
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1st drill a pilot hole using the 3/32 pilot point drill bit.

(you may like to attach a small level to the top of your drill with ducktape or epoxy to get those
pilot holes drilled  straight)

2nd use the countersink bit to make a shallow countersink.
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3rd use the phillips head bit to drive the screw in, the screw should be recessed just a tiny bit to
later allow for wood patch to cover it up.

Do this every 3" of each panel and stud, but not closer than 1" to the edge of each panel

(driving a screw through the edge of a panel could split the wood)

After you attach the floor panel to the side panel, attach the floor studs to the floor panel and
side panel, position the floor studs so that the center of each stud is 25% from the front of the
cabinet and 25% from the back.
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Mark the location of the studs on the bottom of the cabinet as a guide for later attaching the
casters.
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Next attach the roof stud, if you are going to have a roof make sure the roof stud is appropriately
recessed.
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Now attach the front lower panel, make sure it's position is in keeping with your cabinet recess.
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Then attach the rest of the front panels (excluding control panel)
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After attach the lower rear panel.
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I leave my cabinets open on the back for passive cooling of the components and open on the top
for passive lighting of the marquee. Alternately, if you prefer a back door, DC fans mounted in
the back door and roof connected to a 5v line on the computer power supply could cool the

Chapter three "Construction, Part 1"

file:///C|/Documents and Settings/Administrator/Desktop/New Folder/index3.htm (40 of 46) [6/14/2004 1:33:51 PM]



components quietly, and a light can be placed behind the marquee. In this cabinet the lower rear
panel is a 2"X8" board.
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Now it's time to attach the other side panel, lay the cabinet on it's side, and line up the other side
panel using the boundary lines, dry fit and verify before attaching it with screws.

After attach the casters to the bottom of the cabinet (into the floor studs).

Locking swivel casters in front, fixed casters in rear.
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This tutorial and it's entire contents are copyright 2004 SpyStyle Inc
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Chapter four : Construction

Part 2

Continue to attach panels and studs with a course thread drywall screw every 3"

Attach the monitor shelf and under it attach the center studs (attach the studs to both side panels
and monitor shelf)

(you will notice in the pictures I did a few things out of sequence, don't let it confuse you)
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under the monitor shelf
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The monitor shelf
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left side panel
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right side panel
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Now attach the marquee panel and speaker panel.
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If you are going to use a coin door now is a good time to cut the hole for it.

I measured the coin door, marked the front of the cabinet accordingly, drilled pilot holes on each
side of the square I drew (large enough to insert the jig-saw blade) and cut it out with my jig-saw.
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It's now time to patch over the screw holes with wood filler, using a putty knife apply wood patch
to the holes. After it dries use your finishing sander to smooth it out, it may take 3 applications.
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I used 60 grit sandpaper to smooth out the wood filler.
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Now is the best time to route the side panels for the t-molding.

Calibrating the router
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Tighten the slot cutting bit into place on your router and adjust the plunge depth so that it is
perfectly centered on your material, taking blade width into consideration.

You only get one chance to route the sides of your cabinet for the t-molding, so before you cut
the slot on your cabinet's side panel you must calibrate the depth of the router.

Cut al 1" piece of t-molding and route a 2" slot on the side of a piece of scrap material, then
using your rubber mallet pound the 1" t-molding piece into the slot, adjust the plunge depth of
your router accordingly and try again and again until the t-molding is perfectly centered in the
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scrap material.

After you've successfully calibrated the depth of the router lay the cabinet on it's side and put
some heavy things in it so it won't move while you route it.
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Now stand the cabinet up and prepare it for painting by vacuuming it inside and out and the
surrounding area so all is dust free, this is done to prevent dust from settling in the drying paint.
After vacuuming and dusting use a damp towel to wipe down the entire cabinet from top to
bottom, then a dry one.

Prepare your paint shop by spreading a tarp on the floor and rolling the cabinet on to the center,
be sure to change in to scrap clothes and shoes.

When painting always outline the panel first , from top to bottom, then paint the remainder, from
top to bottom keeping your brush strokes going in the same direction.

I outlined the panels with a 2 1/2" nylon bristle cut brush then rolled out the remainder with a 7"
smooth surface roller. However, if you don't have any painting experience I recommend you
paint the cabinet entirely with your brush (outlining first, then painting the remainder, several light
coats)

You may wish to lightly sand in-between coats with 150 grit sandpaper, after sanding use a
damp towel to wipe down the entire cabinet from top to bottom, then a dry one.
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Paint 2 coats of primer, then 2 or more coats of the final color.
Chapter 4 "Construction, Part 2"

file:///C|/Documents and Settings/Administrator/Desktop/New Folder/index4.htm (22 of 42) [6/14/2004 1:34:12 PM]



These pictures illustrate outlining.
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Make sure to wash your brush out completely after each painting session, because the paint is
water based (latex) you can wash it in the sink with warm water. When storing your brush either
hang it by a nail or lay it on a flat surface (so the bristles don't warp). Take good care of your
brush and it will last many years.
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Next install the coin door.

I secured mine with 3/16 carriage bolts, lock-nuts and washers as it had no mounting frame.

In my previous cabinet (the Pac-Man pictured at the top) the coin door had a mounting frame
and I secured it to the front panel by drilling several 3/16 holes around the inside of the frame,
then drove nails through the holes into the front panel. After I attached the coin door to the
mounted frame and switched out the lock with a new 1" cam lock ( "mailbox lock" ) from home
depot.
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Next install the T-molding. Line the t-molding up with the routed slot and pound it in with the
rubber mallet.

It's a good idea to first check and clean out the routed slots of debris using a small flat head
screwdriver.
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I cut away 2" of the T-molding channel with scissors to get around these tight corners.
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After the t-molding is installed mount your speaker(s).

Chapter 4 "Construction, Part 2"

file:///C|/Documents and Settings/Administrator/Desktop/New Folder/index4.htm (33 of 42) [6/14/2004 1:34:12 PM]



Now cut the marquee retainer to your cabinet's internal width, drill several holes along the
bottom and install it with screws.

I mounted my marquee and retainer by first mounting the marquee in place with little brad nails.

Then drilled several 3/16 holes in the bottom of the retainer

Then held it in place and drove drywall screws through the holes.
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These pictures illustrate the mounting holes in the marquee retainer.
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This tutorial and it's entire contents are copyright 2004 SpyStyle Inc
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Chapter five : Preparing the cabinet art

There are allot of arcade art contributors across the internet, and it is easy to find the art for your
cabinet. However, having the art printed at a print shop is very expensive, in this tutorial I will
show you how to print your own cabinet art in segments onto sticker paper.

Ofcourse, bringing the images on disk to a print shop would yeild better results, but the price
may be $10 per foot. This tutorial's printing method costs less than $1 per foot.

First I downloaded the 'Stargate Sideart' from from the internet ( http://localarcade.com/4images/
) and manipulated it to suit the 'Defender Stargate 2&1 cabinet'

 

To print it out I open it in 'Paint Shop pro'
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Then resize it to suit the cabinet side (28" @ 300 pixels per inch)

This is done by clicking : Image > Resize
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Click 'Actual / print size'

Change the units to 'inches'

Make sure the 'resolution' is set to '300 Pixels / inch'

Input the width, make sure 'Maintain aspect ratio' is checked

Now the image is 28" wide, perfect for the sideart but too large to print, so we must cut it into
segments smaller that 8 1/2" X 11" (the standard size of printer paper)

To cut the image into segments we will use a grid that makes 7 1/2" X 10" rectangles over the
image
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Click 'View' then 'Change Grid and Guide Properties'

Change the 'Units' to 'Pixels' and the 'Spacing' to '2250' X '3000'

(for vertical printing, or '3000' X '2250' for horizontal printing)

Chapter five "Preparing the cabinet art"

file:///C|/Documents and Settings/Administrator/Desktop/New Folder/index5.htm (5 of 15) [6/14/2004 1:34:33 PM]



After that click 'View' > 'Grid'

Now the image has a grid over it consisting of 7 1/2" X 10" rectangles, this is an ideal size for
printing onto 8 1/2" X 11" paper
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Click the square 'Selection' tool (see arrow below)
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Then trace over the first rectangle, when finished the rectangle should look like this :
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click 'Edit' > 'Cut'

When 'Cut' that segment will disappear :
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Now click 'Edit' > 'Paste' > 'As New Image' 

Now the section you just 'Cut' appears.
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Save it to a directory on your Hard Drive by clicking 'File' > 'Save As'
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Change the 'Save as type' to 'JPEG'
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Click 'Options' and set the 'Compression factor' to 1 (maximum quality)

(this will only have to be done once)
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Then Input the 'File name' and save it to a directory on your Hard Drive

Repeat this process until your cabinet art is cut into printable segments and saved to your Hard
Drive.

This can be done for all of the cabinet art, printing is covered in the next chapter.
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Chapter six : Constructing the Control Panel

Now that the cabinet is built we make the control panel, I will be using a control panel overlay, 
plexi glass and t-molding to make a very authentic control panel.

 
Shopping List :

5/8" material

1/8" clear lexan (plexi glass)

8 1/2" X 11" Sticker Paper
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Flush trimming router bit
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In this tutorial I will be using a printed control panel overlay as a cutting template, then covering
the control panel with plexi glass and adding t-molding to the front. Of course an overlay, plexi
and t-molding are not necessary for a working control panel but adds to the authenticity of the
cabinet.

First I downloaded a nice control panel overlay graphic from the internet (
http://localarcade.com/4images/ ) and converted it to JPEG format.

Using 'Paint Shop Pro' (or your favorite image editing software) open the control panel overlay
image and resize it's width to match your control panel, then manipulate it as you see fit.
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After, cut it into sections smaller than 8 1/2" X 11" so you can print it out onto the sticker paper.

(see chapter four)
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Then print it out onto the sticker paper, cut the excess with scissors, and stick it to your control
panel.

Make sure you have your program set up to print at 100% size (no scaling).
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After attaching the control panel overlay to the control panel carefully measure and mark the
center of each button and joystick hole. Clamp the control panel to your saw-horses and drill
small pilot holes in the center of each hole.
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After drilling the pilot holes use your 1 1/8" spade bit to drill each hole.

The 1 1/8" spade bit is used for both buttons and joysticks
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Once the holes are cut clamp the lexan to the control panel, and clamp the control panel to the
saw-horses.

Be sure to leave the protective cover on the lexan.
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Then using your router with a cutting bit, cut pilot holes big enough to fit the flush trim router bit
through on each hole.
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After use your flush trim bit to match the lexan to the control panel.
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Use clamps to hold the lexan while routing the sides.
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Using your slot cutting bit route the front of the control panel for t-molding.
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Remove the protective cover from the lexan.
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Install the buttons and stick(s).
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Install the t-molding with the rubber mallet
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If you want to secure the Lexan with screws :

first use your countersink bit in reverse at your drill's highest speed.
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then use a non-pilot point 1/8" drill bit drill in reverse at your drill's highest speed.

Chapter six "Constructing the Control Panel"

file:///C|/Documents and Settings/Administrator/Desktop/New Folder/index6.htm (28 of 39) [6/14/2004 1:34:59 PM]



after drill a 1/8" pilot hole and insert a screw.
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To attach the control panel to the cabinet I will use double wide brackets, this will make the
control panel removable for future upgrades.

Measure and place the brackets so they match the internal width of your cabinet.
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To attach the brackets to the control panel trace the bracket holes with a pencil.
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Then drill very shallow pilot holes.
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after attach the brackets with 1/2" wood screws.
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Have a helper hold the control panel in place while you secure the control panel brackets to the
inside of the side panels with 1/2" wood screws.
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Inside the cabinet, under the control panel
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The back of the coin door, and under the control panel.
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Placing the 'coin up' buttons discretely under the coin door keeps the control panel uncluttered.

Chapter six "Constructing the Control Panel"

file:///C|/Documents and Settings/Administrator/Desktop/New Folder/index6.htm (38 of 39) [6/14/2004 1:34:59 PM]



Stay Tuned :)

This tutorial in its entire contents copyright 2004 SpyStyle Inc.
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